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INTRODUCTION 

ReDJ is a Joomla! 1.5 native extension that allows you to efficiently manage URL redirections. This is very 

useful for creating URL aliases, and managing redirections from an old URL to a new one. A very similar 

extension has been added into Joomla! 1.6, but ReDJ supports powerful regular expressions that allow to 

match more than one source URL. In this way it is possible to create a group of redirections with just one 

ReDJ item. In the following paragraphs we will learn how to make better use of regular expressions to take 

full advantage from ReDJ. 

Since version 1.5, ReDJ also supports usage of “macros” into destination URL. This allows to create a 

dynamic destination URL where the destination can change according with the source URL. Another great 

feature introduced is the configurable redirection type for each item, with support for 301 (Moved 

Permanently), 307 (Temporary Redirect) and also 200 (Internal Redirect) (available for Enterprise version 

only). With the Internal Redirect is now possible to create a "real" URL alias with Joomla!. 

Last but not least, there are many other features added to last ReDJ version, such custom error pages or 

referer tracing that can dramatically improve your SEO ranking. We will describe each one in detail in the 

next part of this guide. 

 

HOW IT WORKS 

ReDJ consists of a component for managing list of redirection items, and a plugin that is in charge of 

intercept the site calls and redirect them to another page when needed. Since version 1.5 of ReDJ there is 

just one package to download and install. These are the main steps to make it work (for geeks): 

1. Install the package using Joomla! Administration interface; 

2. Activate the plugin “System - ReDJ” and set its position and global parameters; 

3. Use ReDJ component's functions to manage redirections, errors and referers. 

Detailed instructions on each step are described in the following paragraphs. In this section we just want to 

focus on some basic concepts related to ReDJ and how it works. 

The first important thing to understand is the “item” concept. With ReDJ Manager (the component 

interface) you can create as many “item” as you want, and each item has its redirection rule. But not 

necessarily an item corresponds to a single page (i.e. matches just a single URL). 

An item has a “From URL” field that can be full URI or just a part of it. For example, if the configured “From 

URL” field for an item is “/home.html”, then this item matches both the URL 

http://www.mysite.com/home.html  and http://www.mysite.com/orders/home.html?view=status. So, it 

means that with a single item is possible to match multiple source URLs. 

http://www.mysite.com/home.html
http://www.mysite.com/orders/home.html?view=status
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When an user requests a site URL, the plugin take the “path+query” parts of the URL1 and compares this 

string with the list of (published) item’s “From URL”, considered in their order set. The first matching item 

found (if there’s at least one) is used for redirect. 

Last thing to understand about the item is that the “From URL” field can be a regular expression. These 

provide a powerful way to specify complex search patterns for matching URL. In the next paragraphs will be 

shown many regular expression examples. 

 

INSTALLATION PROCEDURE 

Since version 1.5 of ReDJ there is just one package to download and install. This package include both the 

needed component and plugin, and support the installation with “upgrade” mode, so there’s no need any 

more to uninstall any previous version of ReDJ. 

To install ReDJ, login to Joomla! backend as administrator, and go to menu “Extensions” -> 

”Install/Uninstall”. 

Click the browse button, select the package file (ReDJX.XCommunity.zip or ReDJX.XEnterprise.zip) and 

click the install button. 

 

That’s all. Now we are ready to start using ReDJ. 

  

                                                             
1 NOTE: The URL’s parts “scheme”, “user”, “pass”, “host” and “port” are dropped, so the domain name must not be 
included in the item’s URI field. 
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UPGRADE PROCEDURE 

If you are upgrading from a previous version of ReDJ,there is no need to first uninstall old component and 

plugin. As mentioned earlier, since version 1.5 of ReDJ the “upgrade” mode is supported for the 

installation, so just install the new package over the old one, both component and plugin will be upgraded. 

Note that when upgrading ReDJ also the database tables are upgraded without to delete any table data, 

so your items will be preserved. It is in charge of the installation process to upgrade tables structure as 

needed. 

 

USAGE 

Remember that is the plugin that “do the work”. ReDJ component is just an administrative interface that let 

you manage your items, but is the plugin that check site calls and perform the redirects when needed. So, 

first thing is to enable the plugin. Note that if you need to disable ReDJ, just disable the plugin. 

Go to menu “Extensions” -> “Plugin Manager”, find “System - ReDJ” in the list and click on it to enter into 

configuration page. 

 

Set “Enabled” to “Yes”, and set other parameters on the right side according to your needs. Look at “Plugin 

settings” paragraph for detailed information of each parameter. 

Click on “Save” and check that the plugin is enabled. 
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Last thing to check is the plugins order that can be much important, especially if there are some other 

plugins that mess with source URL, redirections and aliases. Normally, it should be better to put ReDJ as 

the first system type plugin in the list, so it will be the first to catch any page call. 

Now ReDJ is ready to work! Let’s create our first item, and after this let’s test the redirect from the web 

browser. Note that you could get a cached page. To avoid this, remember to clear server-side cache from 

Joomla! Backend (menu “Tools” -> “Clean Cache”, “Site” tab, select all and click “Delete” button), and 

client-side cache from your web browser. 

To add an item go to menu “Components” -> “ReDJ” –> “Items”,  and click on “New” button. It will be 

shown a screen for entering information related to an item. The “From URL” field must contains an “URL 

part” to compare with browser URL. Remember that “From URL” must not contains URL’s parts “scheme”, 

“user”, “pass”, “host” and “port”. 

 

The field “To URL” contains the destination URL where to redirect the browser for any URLs that match 

with this item. The field “Redirect” specify redirection type to use. There are three options available: 

 301 (Moved Permanently) 

 307 (Temporary Redirect) 

 200 (Internal Redirect) 
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The last option is an advanced feature available only in the Enterprise version of ReDJ. This option let you 

change the destination page returned to web browser “internally” to Joomla!, so that the user does not 

notice any URL changes.2 

The field “Case sensitive” specify if the match between item and current URL must consider the letters case 

(i.e. uppercase and lowercase are considered different). So, in case sensitive mode the item must match 

with current URL also for the case of characters. If case sensitive is off, no matter if item or current URL 

differs only for case of characters (i.e. MyPage.php = myPage.PHP = mypage.php). 

Finally, the field “Hits” counts the number of times this item were used, while the field “Last visit” indicates 

the last time this item were used. Here you can change the counter value if needed. 

In our example, case sensitive is enabled, source and destination are: 

From URL: /testme.html 

To URL: http://{siteurl}/index.php 

We must talk in the plural when we say “URLs that match with this item” because the URL part specified as 

“From URL” in a single item can match more than a single browser URL. In the previous example, with 

“/testme.html” we match ANY URL in the form: 

http://www.mysite.com/testme.html 

http://www.mysite.com/testme.html?itemid=xxx 

… 

http://www.mysite.com/directory/testme.html?id=xxx 

This behavior makes ReDJ very flexible, but that’s not all. 

It is also possible to use Regular Expressions into “From URL” field. ReDJ, in fact, supports regular 

expressions according to Henry Spencer's implementation: 

http://dev.mysql.com/doc/refman/5.0/en/regexp.html 

And this feature makes it extremely powerful when you can master it.  

The following table shows some examples. Look at “Examples and Solutions to common problems” 

paragraph for more advanced examples. 

                                                             
2 The internal redirect is available for choose also in the Community version. But in this case a 301 redirect is made 
when the item matches. 

http://www.mysite.com/testme.html
http://www.mysite.com/testme.html?itemid=xxx
http://www.mysite.com/directory/testme.html?id=xxx
http://dev.mysql.com/doc/refman/5.0/en/regexp.html
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“From URL” field What does it mean 

/section/*$ The dollar ($) means “end with”. The star (*) means “match 

zero or more occurrences of previous character”, that is the 

slash (/). So, the “From URL” field means “address ends with 

/section or /section/”. 

^/section/9-article.html$ The hyphen (^) means “start with”. The dollar ($) means “end 

with”. So, the “From URL” field means “address starts and ends 

exactly with /section/9-article.html”. 

^/section/11-articles.php\?id=12$ The hyphen (^) means “start with”. The dollar ($) means “end 

with”. Also, we need a “literal” question-mark (?) for inline 

arguments, so it must be escaped with a backslash (\?).  So, the 

“From URL” field means “address starts and ends exactly with 

/section/11-articles.php?id=12”. 

Last thing to know about the source matching address is that even the items order is important. For each 

URL request, ReDJ searches all the matching (published) items, but ONLY THE FIRST ONE in the ordering set 

is used. This can be useful, as example, to distinguish a category from its articles. If we have two URLs as 

follow: 

http://www.mysite.com/category/ 

http://www.mysite.com/category/article-1.html 

Items could be configured with the following “From URL” field: 

Item Order Wrong Order Correct Order 

5 /category/ /category/article-1.html 

6 /category/article-1.html /category/ 

For the browser URL http://www.mysite.com/category/article-1.html, if items are set in the wrong order, 

both items match the URL, but remember that only the first matching item (/category/) is applied, so the 

redirect for page article-1.html will never be used. 

http://www.mysite.com/category/
http://www.mysite.com/category/article-1.html
http://www.mysite.com/category/article-1.html
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INTERNAL REDIRECT 

As mentioned earlier, the Enterprise version of ReDJ introduces a new feature, the Internal Redirect. 

The 301 (Moved Permanently) or 307 (Temporary Redirect) redirects are client-side. The user from his web 

browser requests a page (the From URL), and the web server responds with the address to which the page 

was moved (the To URL). At this point, is the browser that requests the new address ( i.e. is the browser to 

perform the redirect). 

With the “Internal Redirect” instead, is the web server that changes the page returned to web browser with 

the new destination. The result is a server-side redirect (i.e. the redirect happens “internally” to Joomla!), 

so the user does not notice any URL change. 

This is a great way to create URL aliases and short URLs. Just as example, consider an URL like the following: 

http://www.yoursite.com/index.php/component/reservation/event/4/forum 

It’s possible to create a ReDJ item with redirection type 200 (Internal) that match to the following URL: 

http://www.yoursite.com/training 

Page and content returned by Joomla! are exactly the same for both URLs, but the shortest URL is much 

better for SEF and SEO. 

 

DYNAMIC DESTINATIONS 

In this paragraph we will take a deeper look at “To URL” destination field. Since version 1.5 of ReDJ, a 

support for complex macros has been added, and this allows to create dynamic destinations. When the 

browser URL matches with the “From URL” source field of an item, if its destination contains one or more 

macros, the plugin first explodes the macros and builds the final “real destination” URL, replacing each 

macro with its current value, and finally performs the redirect. Macros can take and elaborate parts of the 

current matching URL (e.g. a query var), so this let you create dynamic destinations strictly related to the 

source URL. Referring to an URL like the following: 

 

Here is a list of supported macros for destination “To URL” field: 

 

http://www.yoursite.com/index.php/component/reservation/event/4/forum
http://www.yoursite.com/training
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Macro Example 

{siteurl} www.example.com/path/to/Joomla 

{scheme} http 

{host} www.example.com 

{port} 8080 

{user} fredbloggs 

{pass} itsasecret 

{path} /path/to/Joomla/section/cat/index.php 

{query} task=view&id=32 

{queryfull} ?task=view&id=32 

{querybuild id,task} id=32&task=view 

{querybuild id,task=edit} id=32&task=edit 

{querybuild 

id,task=view,ItemId=12} 

id=32&task=view&ItemId=12 

{querybuildfull id,task} ?id=32&task=view 

{querybuildfull id,task=save} ?id=32&task=save 

{querybuildfull 

id,task,action=close} 

?id=32&task=view&action=close 

{querydrop task} id=32 

{querydrop id,task=edit} task=edit 

{querydrop 

id,task=save,action=close} 

task=save&action=close 

{querydropfull task} ?id=32 

{querydropfull id,task=save} ?task=save 

{querydropfull 

id,task=edit,action=close} 

?task=edit&action=close 

{queryvar task} view 

{queryvar id} 32 

{authority} fredbloggs:itsasecret@www.example.com:8080 

{baseonly} /path/to/Joomla (empty when installed on 

root, i.e. it will never contains a trailing 

slash) 

{pathfrombase} /section/cat/index.php 

{pathltrim /path/to} /Joomla/section/cat/index.php 

{pathrtrim /index.php} /path/to/Joomla/section/cat 

{pathfrombaseltrim /section} /cat/index.php 

{pathfrombasertrim index.php} /section/cat/ 

{preg_match 

N}pattern{/preg_match} 

(return the N-th matched pattern on the full 

source url, where N = 0 when not specified) 

{preg_match}/([^\/]+)(\.php|\.ht

ml|\.htm)/i{/preg_match} 

index.php 

{preg_match 

2}/([^\/]+)(\.php|\.html|\.htm)/

i{/preg_match} 

.php 

http://www.example.com/
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Macros highlighted are only available for Enterprise version of ReDJ. 

Here a practical example of dynamic destinations: 

Source URL http://www.yoursite.com/old/index.php?task=view&id=123&ItemId=3 

ReDJ “To URL” http://{siteurl}/new.html{querybuild ItemId=12} 

Destination URL http://www.yoursite.com/new.html?task=view&id=123&ItemId=12 

 

ADDITIONAL FUNCTIONS  

Beside the core redirect functionality, ReDJ offers some additional features that can be very  useful. In the 

following paragraphs these functions will be described in detail. 

 

PAGES 404 

In this component section it’s possible to create custom error pages that can replace the Joomla!’s standard 

one. 

 

 

Within ReDJ, as default, there are always defined two predefined pages, with titles “Italiano” (ID = 1) and 

“English” (ID = 2). These are example pages, added just to show how to create HTML for a custom error 

page. Specifically, these pages are perfectly identical to the Joomla!’s standard error page, except they add 

the email address of site’s Administrator, showing how to use supported macros. 

BEWARE: don’t customize these pages, because on each ReDJ upgrade these are deleted and recreated, 

so any changes will be lost. It’s better to add a new page (ID > 2) and use this. 



ReDJ – Quick Guide Rev. 4 

 

12 www.sistemistica.it 

 

For any custom error page the following fields are available: 

Name Value Description 

Title Text The title to identify the custom error page. 

Language Name Text The language identifier for the custom error page. 

Page Text 

Insert HTML code of the custom error page. The 

following macros can be used: 

 {siteurl} Site web address 

 {sitename} Web site name 

 {sitemail} Address used to send site mail 

 {errormessage} Description message of 

occurred error 

 {article ID} Include an article (intro and 

fulltext). Replace "ID" with content item ID to 

include 

Hits Integer 
Number of times the custom error page were used 

(i.e. returned to site visitors). 

 

Once a page was created, to replace the Joomla!’s standard error page with this custom one, its ID number 

must be specified in the plugin settings. See paragraph “ Plugin settings” for more details. 

 

ERRORS 

With this function it is possible to record all the error calls that the site receives. So a kind of trace log for 

error requests is available, and this can be useful to identify dead backlinks that need to be redirected 

elsewhere. Analyzing this log it is also possible to  extract other useful information (e.g. to detect if the site 

is subject to hacker attacks like remote file inclusion or sql injection). 
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For any error item in the list the following fields are available: 

Name Value Description 

Visited URL Text 
Absolute wrong URL called by users (e.g. 

http://www.yoursite.com/an-old-page.html). 

Error Code Integer 
The error code generated by Joomla! for the page 

(usually 404 – Not Found). 

Hits Integer Number of times the wrong URL was called by users. 

Last Visit Datetime 

This field reports the timestamp for the last time 

which wrong url was called by an user. This is useful to 

check if the problem is solved by a redirection (in this 

case, the timestamp doesn’t change anymore). 

Last Referer Text 

This field reports the site referer for the last request of 

the wrong url. This is useful to identify which sites has 

dead backlinks to your pages. 

 

Beware that this feature must be activated with a corresponding option in the plugin settings. See 

paragraph “ Plugin settings” for more details. 

 

REFERERS 

This feature allows to record all the referers for site visitors. A trace log with all referers is available, and 

this can be useful to identify traffic sources for the web site. 

  

http://www.yoursite.com/an-old-page.html
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For any referer item in the list the following fields are available: 

Name Value Description 

Visited URL Text 
Absolute URL visited by users (e.g. 

http://www.yoursite.com/trackme.html). 

Referer URL Text 
Absolute URL of the referer site where the user comes 

from (e.g. http://www.myfriend.com/linktome.html). 

Domain Text 
This field reports just the domain part for the referer 

site URL (e.g. www.myfriend.com). 

Hits Integer 
Number of times the referer URL was detected for the 

visited URL in site’s visits. 

Last Visit Datetime 

This field reports the timestamp for the last time 

which referer URL was detected for the visited URL in 

site’s visits. This is useful to check active referer URLs. 

 

Beware that this feature must be activated with a corresponding option in the plugin settings. See 

paragraph “ Plugin settings” for more details. 

 

PLUGIN SETTINGS  

In this paragraph we will explain the meaning of each plugin parameter. To edit plugin settings go to menu 

“Extensions” -> “Plugin Manager”, find “System - ReDJ” in the list and click on it to enter into configuration 

page. 

  

http://www.yoursite.com/trackme.html
http://www.myfriend.com/linktome.html
http://www.myfriend.com/
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Basic Plugin Parameters 

 

In the following table there’s a list of all basic plugin parameters. 

Name Value Description 

Custom error 404 page No/Yes 
No, disables. Yes, replace Joomla! standard error page 

with a custom one. 

Error 404 page ID Integer 

The identification number for the custom error page 

to use. Beware that this refers to pages created under 

the ReDJ component, section “Pages 404”. The page is 

used only when “Custom error 404 page” option is set 

to Yes. 

Track errors No/Yes 
No, disabled. Yes, enable errors trace for site URL calls 

(trace data are visible under ReDJ component). 
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Track referrers No/Yes 
No, disabled. Yes, enable referers trace from site 

visitors (trace data are visible under ReDJ component). 

Referers to exclude Text 

List of domains to ignore when tracing referers from 

site visitors, one per row (e.g. www.google.com). The 

following macros are also available and can be 

indicated each one on a single row: {self} to exclude 

the own domain (i.e. internal referer), {none} to 

exclude visits without referer. 

Redirect any error No/Yes 

No, disabled. Yes, redirect any error call, that don’t 

match with any (active) redirect item, to a common 

destination page. Beware that this also replace the 

custom error 404 page, just because no more error 

404 can be obtained from site calls. 

Redirect URL Text 

Absolute URL where to redirect all the errors with a 

301 return code (e.g. http://www.google.it). The URL 

is used only when “Redirect any error” option is set to 

Yes, and only if none of the enabled items match with 

the error URL (i.e. after redirect phase). A {siteurl} 

macro is also supported here. 

 
  

http://www.google.it/
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Advanced Plugin Parameters 

 

In the following table there’s a list of all advanced plugin parameters. 

Name Value Description 

Use early redirect No/Yes 

Check for redirect in a early phase. Useful only for 

Internal Redirect (Enterprise version), to prevent 

conflict with other extensions (e.g. Joomfish) 

Base path Text 

The Joomla base installation path (e.g. /myportal if the 

site's homepage is http://www.mysite.com/myportal). 

This string will be dropped from the current URI, so to 

increase portability for configured items. Leave blank 

if the site is installed on the root. 
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EXAMPLES AND SOLUTIONS TO COMMON PROBLEMS 

These are some of the common questions posted on support forum. 

How to Solution 

Match only site’s homepage: 

 

http://www.mysite.com/ 

Create an item with the following “From URL” field: 

 

^/$ 

 

The expression means “start and end with slash (/)” (i.e. 

there’s ONLY the slash). 

Match an URL with one or more parameters: 

 

http://www.mysite.com/catalog.php?page=1&order

=asc 

Create an item with the following “From URL” field: 

 

/catalog.php\?page=1&order=asc 

 

or 

/catalog.php[[.question-mark.]]page=1&order=asc 

 

In both cases you need to “escape” the question mark (?). You 

can do it with a backslash (\) behind, or replacing with string 

“[[.question-mark.]]”. 

Match all the URLs in the following form: 

 

/index2.php?option=com_content&task=view&id=1

59&pop=1&page=52&Itemid=10218 

/index2.php?option=com_content&task=view&id=1

7&pop=1&page=0&Itemid=72 

/index2.php?option=com_content&task=view&id=3

01&pop=1&page=0&Itemid=10440 

/index2.php?option=com_content&task=view&id=7

7&pop=1&page=0&Itemid=113 

… 

Create an item with the following “From URL” field: 

 

/index2.php\?option=com_content&task=view&id=[0-

9]{1,3}&pop=1&page=[0-9]{1,2}&Itemid=[0-9]{1,5} 

 

The expression [0-9]{1,5} means “a sequence from 1 to 5 

digits”. 

 

  

http://www.mysite.com/
http://www.mysite.com/catalog.php?page=1&order=asc
http://www.mysite.com/catalog.php?page=1&order=asc
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GET SUPPORT 

If you need help with ReDJ, post a request on support forum: 

http://www.sistemistica.it/forum.html 

To send us private data like access credentials to your backend, use the contact email: 

info@sistemistica.it 

 

SUPPORT US 

If you like this extension and found it useful, would you consider a small donation to support both site and 

development. It's easy... just go to menu “Components” -> “ReDJ”, select the “About” tab, and click on 

Paypal image button, or use the link below: 

 

https://www.paypal.com/cgi-bin/webscr?cmd=_s-xclick&hosted_button_id=BBZ3X39XRYWZ2 

 

http://www.sistemistica.it/forum.html
mailto:info@sistemistica.it
https://www.paypal.com/cgi-bin/webscr?cmd=_s-xclick&hosted_button_id=BBZ3X39XRYWZ2
https://www.paypal.com/cgi-bin/webscr?cmd=_s-xclick&hosted_button_id=BBZ3X39XRYWZ2
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